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Getting Started

System Requirements
EZPlot runs with the EZChrom 200 data system written by MTI Analytical
Instruments for their Microsensor Gas Chromatographs.  It is not designed to run
with any other version of the EZChrom Data System.  To run EZPlot you will need
the following:

• Microsoft Windows version 3.11 or Windows 95

• MTI Analytical Instrument’s EZCHROM 200 version 4.5 data system

• Up to 3 MB of  free disk space depending on the program components
that you install.

• A 50-MHz 80486 or better computer

• 16 MB of system memory (RAM) or better is recommended

• VGA or better color display

Program Installation
The EZPlot installation disk contains a single file:  SETUP.EXE.  It is a Windows
self-installing setup program that contains all the required EZPlot program files.
The setup program copies these files from the installation disk to your local hard
drive.  It will also add the EZPlot icon to the MTI program group.

Windows 3.1

1. Place the EZPlot installation disk in the floppy disk drive

2. From the Windows 3.1 Program or File Manager, click File and choose
RUN

3. When the dialog box appears, type a:setup (enter b:setup if you
placed the installation disk in the B diskette drive) and click OK

4. Follow the instructions provided by the setup program

Windows 95

1. Place the EZPlot installation disk in the floppy disk drive

2. Click on  Windows 95 Start Button and choose the Run option



4  ••  Getting Started EZPlot 4.5 Copyright 1997, Diablo Analytical, Inc.

3. In the Open dialog box, type a:setup (enter b:setup if you placed the
installation disk in the B diskette drive) and click OK

4. Follow the instructions provided by the setup program

Sample Data Files
During setup you will be given the option to install sample data files.  If you select
this option the following data files will be installed onto your system.

File Name Description Location

ezplot.ezp EZPlot data file Default EZChrom "Chrom"
directory

ezplot.gra Graph template file for
ezplot.ezp

"

testdata.1 - testdata.5 EZChrom data files "

testdata.prn EZChrom PRN file created
by the testdata data files and
method

"

testdata.met EZChrom method file for the
corresponding data files

Default EZChrom "Methods"
directory

The data file "ezplot.ezp" is a sample EZPlot data file that can be loaded directly
using the "Open Graph" option of the EZPlot "File" menu .  It automatically uses the
graph template file "ezplot.gra" to define graph formatting.

The "testdata" files can be used to simulate real time plotting via the "recall" feature
of EZChrom.  The file "testdata.prn" can be used to investigate the import feature of
EZPlot by using the "Import EZChrom PRN File" option of the EZPlot "File" menu.

Product Registration
In order to receive technical support and information regarding future updates to
EZPlot, you will need to return the registration form that is included in the diskette
envelope.  Fill out the registration form and fax it to the number listed on the form.

Technical Support
Technical support for EZPlot is available directly through Diablo Analytical.

Phone
If you want to speak directly with technical support, call us at (510) 609-1150.

Fax
Make a copy of the Technical Support Fax-Back Form that you received with this
manual.  Fill it out with a description of your problem or suggestion and fax it to us at
(510) 609-9360.
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Electronic Mail
Use our dedicated EZPlot support address for e-mail based technical support:
ezplot@diab.com

World Wide Web
We will be adding EZPlot support information to our World-Wide Web site in the
near future:   http://www.diab.com.

Uninstalling EZPlot
Windows 3.1

If you performed a full EZPlot installation, there should be a an uninstall icon present
in the program manager group into which you installed the EZPlot Icons:

Double click on the "Uninstall EZPlot" icon and follow the instructions to remove
EZPlot from your system.

Windows 95

From the Windows 95 Control Panel, double-click the Add/Remove Programs
Icon.  Select the Install/Uninstall Tab and then  select EZPlot 4.5 in the list box.
Press the Add/Remove button and follow the instructions to remove EZPlot from
your system.
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Introduction

What is EZPlot
EZPlot is a utility that adds real-time trend plotting capabilities to the EZChrom 200
data system that is supplied with MTI Analytical Instrument's portable gas
chromatographs.  In addition to real-time trend plotting, EZPlot also allows
convenient off-line evaluation of concentration data.  Some of EZPlot's features are
listed below:

• Creates concentration trend plots for up to 10 overlaid components

• Provides for either real-time or post-run trend plotting and data analysis

• Calculates the average, standard deviation, %RSD, minimum and
maximum values for all components

• Allows the user to set upper and lower control limits that can be
displayed on the trend plot

• Allows the user to set local alarms that are linked to the control limits

• Graph templates can be saved and applied to new data files

• Can import EZChrom PRN files, or retrieve concentration results from
EZChrom in real time using Dynamic Data Exchange (DDE)

The following screen shot illustrates how EZPlot integrates with EZChrom to provide
easy-to-implement real-time trend plots.
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Screen shot of EZChrom 200  (left panel) and EZPlot (right panel) acquiring and plotting
real-time chromatographic data

About Diablo Analytical, Inc.
Mt. Diablo is a well-known
San Francisco Bay Area
Mountain

EZPlot was written by Diablo Analytical, Inc.  Diablo Analytical is an analytical
application development company located in Concord, CA.  We specialize in the
development of custom analytical solutions for a broad range of industries.

  Diablo Analytical, Inc.
1110 Burnett Avenue, Suite C
P.O. Box 5889
Concord, CA  94524

Phone:  (510) 609-1150
Fax: (510) 609-9360

E-Mail: diablo@diab.com
WWW: http://www.diab.com
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Overview of EZPlot

Overview of EZPlot Main Window
When EZPlot is started, the following main window is displayed.  Descriptions of
each of the components of this main window follow below.  In addition, see
"Description of EZPlot Menu Options" on page 14, for information regarding
EZPlot's menus.

The Main EZPlot Display
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Title Bar:

The filename of the current EZPlot Data file is shown in brackets in the EZPlot Title
bar.

Component:

This list box contains the names of all the components that you have selected to plot.
When you select a component name in this list box, it's legend text and plot color will
change to red to help you identify which plot belongs to this component.  In addition,
the average value and %RSD for the selected component will be displayed in the
panels below.  If you have specified control limits for this component, they will be
displayed on the chart.

Points:

During real-time trend plotting, the number of the last run that was collected is shown
in this panel.  During off-line plotting, the total number of points in the graph is
displayed in the panel.

Avg:

The average value for the selected component is displayed in this panel.

%RSD:

The %RSD for the selected component is displayed in this panel.  The %RSD is
calculated as follows.

%RSD =  
Average Conc.

Std.  Dev.
  100×

Alarm Status Panel:

This status panel, located in the lower right hand corner of the main EZPlot Window,
is the visual alarm indicator. If an alarm has occurred, this panel will turn from gray
to red.  If you double click on this panel, the EZPlot Alarm Log will be brought into
view.

EZChrom Status Panel:

This status panel, located in the lower right hand corner of the main EZPlot Window,
is the real-time plot indicator.  If EZPlot has made a successful DDE connection to
EZChrom, this panel will turn from gray to green.  Real time trend plotting can only
occur when this connection has been made, and the status panel is green.  If you
double click on this status panel, the real time plot setup dialog box is displayed.

EZPlot Trend Plot Window:
The EZPlot trend plot is displayed in this window.  Up to 10 of the components in
the data table can be plotted overlaid in the Trend Plot Window. The appearance of
the plot can be customized by adding titles and gridlines to the graph, changing the
format of the trend lines, etc.
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EZPlot Trend Plot Window

Graph Hot Spots

The plot that is displayed in the EZPlot window is active - pointing to a particular
point on the graph will cause the corresponding run number, time of acquisition,
component name, and concentration value to be displayed in the status panel at the
bottom of the main EZPlot window.  Please note, you must click on the actual data
point, not on the line in order for this feature to work.

EZPlot Data Table Window
The EZPlot data table contains the concentration data for all the components in the
current data file.  The data for each component is contained in a single column with
the component name at the top.  Statistical information for each component is
displayed below the component name in the same column.  Component data appears
in the scrollable region below the statistical summary.  Each row of data contains the
run number, acquisition date and time, followed by the concentration of each
component in the data file.
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EZPlot Data Table Window

Copying Data to the Clipboard

You can copy some or all of the data in the data table to the Windows Clipboard.
Select the region of the data table that you want to copy using the mouse.  Next, type
either "Ctrl-C", or "Ctrl-Insert" at the keyboard.  The selected region will be copied
as tab-delimited data to the clipboard.  If you want to copy the entire data table
including the component names, statistical information, run numbers, and acquisition
times, select "Copy All Data to Clipboard" from the "Edit" menu option.

Alarm Points

If you have enabled alarms for certain components, the cells in the data table
containing the data points that exceeded the alarm levels will be highlighted in red to
allow you to find them quickly.

EZPlot Alarm Log Window
The EZPlot Alarm Log Window contains information about any data points that have
exceeded the upper control limit (UCL) or lower control limit (LCL) for any
components for which you have enabled limits and alarms.  This table contains the
run number, date/time stamp, component name (and number), the limit that was
exceeded (UCL or LCL), and the component concentration for each alarm.  You can
bring the EZPlot Alarm Log into view quickly by double-clicking the Alarm Status
Panel located at the bottom of the main EZPlot Window.
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EZPlot Alarm Window

Clear Alarms Button

You can clear the alarm log by pressing the "Clear" button.  All current alarms will
be erased, and the audible alarm will be silenced.

Audible Alarm Toggle Button

When alarm conditions exist, an audible beep will be transmitted to the computer's
internal speaker at 1-second intervals.  If you would like to silence this audible alarm
without clearing the alarm log, press the audible alarm toggle button.  If you would
like to enable the audible alarm, press the toggle button a second time.

Description of EZPlot Menu Options

File Menu Option

Open Graph

Existing EZPlot data files can be loaded by selecting the "Open Graph..." option
from the "File" menu selection.  EZPlot data files have a file extension of "EZP".

Import EZChrom PRN File

EZPlot can import data from EZChrom PRN files.  In order for EZPlot to properly
read the EZChrom PRN files, they must have been created without the "Extended"
option being checked in the EZChrom Run Setup dialog box.  After importing an
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EZChrom PRN file, make sure to save it so that it is converted to the EZPlot data file
(EZP) format.

Apply Graph Template

You can apply an alternate graph template to the current EZPlot Graph.  EZPlot
graph template files have a file extension of "GSP".

Plot Data

If a data file has already been loaded, then the "Plot Component" dialog box can be
activated by selecting "Plot Data…" from the "File"  menu option.  The plot
component dialog box allows you to select up to 10 components to be plotted.  Select
or deselect a component by either double clicking the component name, or by
selecting a particular component and pressing the space bar.

Plot Component Dialog Box:

Plot Button

Plots the selected components overlaid in the EZPlot Trend Plot Window.

Cancel Button

Closes the Plot Components dialog box without plotting the selected components.

Real-Time Plot

This menu option displays the Real-Time Plot Configuration dialog box.  For more
information see "Real-time plotting with the EZChrom data system" on page 34.

Save Graph

This menu option will save the current EZPlot data and graph configuration to the
data file that is displayed in the EZPlot title bar.  EZPlot creates two separate files
when you save a graph.  One file (.EZP) contains the actual graph data, as well as
control limit and alarm configurations.  The other file (.GSP) contains information on
the format of the graph itself.

Save Graph As

This menu option allows you to save the current graph and data to a new filename.
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Save Graph Template

This menu option allows you to save the current graph configuration so that it can be
used as a template for other graphs.

Print

You can print EZPlot Graphs, component summary data, and the alarm log by
selecting "Print…" from the EZPlot "File" menu.

EZPlot Print Dialog Box

Print Graph

If you want to print the current graph, select this check box.  EZPlot prints graphs in
Landscape mode.  In addition, the printed graph will have the same aspect ratio
(width to height ratio), and relative font sizes as the graph you see on the screen.
Before printing a graph, you can adjust the width and height of the EZPlot Trend Plot
Window, and the sizes of the various fonts  to give the best results.  You will not be
able to select this option until you have plotted at least one component.

Print Component Summary

If you want to print a summary of the component data, select this check box.  The
component summary includes the component name, component number, average
value, standard deviation, %RSD, maximum value, minimum value, control limit
mode, and the upper and lower control limit values.  You can choose to print a
summary for all the components in the data file, or just those that you plotted.  You
will not be able to select this option until you have opened or imported a data file.

Print Alarm Log

If you check this box, the current alarm log will be printed.  You will not be able to
select this option until you have until at least one alarm is present in the alarm log.

Print

When you click the "Print" button, the options that you selected will be printed to the
default Windows printer that is displayed at the top of the dialog box.
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Print Setup

Activates the Windows Printer Setup common dialog box, allowing you to change
the settings of the default printer or choose another printer:

Print Setup Dialog Box

Edit Menu Option

Copy Graph to Clipboard

The graph that is currently displayed in EZPlot can be copied to the Windows
Clipboard by selecting "Copy Graph to Clipboard" from the "File" menu option.
This allows an EZPlot graph to be pasted into another Windows application such as a
word processor.  The graph is copied exactly as it currently appears in the EZPlot
Trend Plot Window.

Copy All Data to Clipboard

This menu option causes the entire data table, including the statistical summary to be
copied to the Windows Clipboard.  The data is copied in "tab-delimited" format.
This means that the data can be pasted directly into a spreadsheet program such as
Microsoft Excel, and should be separated properly into rows and columns.  Please
note that the Windows Clipboard has a limited capacity, and may be unable to hold
all the data for a very large data file.

Copy All Alarms to Clipboard

This menu option causes the entire alarm log to be copied to the Windows Clipboard.
The data is copied in "tab-delimited" format.  This means that the alarm information
can be pasted directly into a spreadsheet program such as Microsoft Excel, and
should be separated properly into rows and columns.

Clear Alarms

You can clear the alarm log by selecting  the "Clear Alarms" menu option.  All
current alarms will be erased, and the audible alarm will be silenced.

Clear All Data

Selecting "Clear All Data" from the "Edit" menu option causes the current graph to
be erased and all data variables re-initialized to zero.  In addition to clearing the
graph, the data table and alarm log are also reset.  Data are automatically reset when
a new data file is loaded into EZPlot.
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Format Menu Option

Graph Properties

Displays the EZPlot Graph Properties tabbed dialog box.  Graph properties such as
line styles, titles, axis scale, and trend lines can be specified via this dialog box.  See
"Setting Graph Properties" on page 21.

Limits and Alarms

This menu option displays the EZPlot Control Limits and Alarms dialog box.  This
dialog box allows you to define the type of control limit to be used, and whether or
not alarms will be generated for each component in the data file.  See "EZPlot
Control Limits and Alarms" on Page 38 for more information.

Zoom Full Scale

If you select this menu option, the Y-axis (concentration) scale of the trend plot will
be adjusted so that the data points and control limits for all plotted components will
be visible.

As long as this menu option is checked, EZPlot will automatically zoom the graph
full scale each time it is drawn.  This setting overrides any manual changes you might
make using the Graph Properties Axis settings.  Uncheck both this option and the
Zoom Selected Component menu option to allow manual changes to remain in effect
the next time the graph is redrawn.

Zoom Selected Component

If you select this menu option, the Y-axis (concentration) scale of the trend plot will
be adjusted so that all data points and control limit lines for the component selected
in the EZPlot Component List Box will be visible.

As long as this menu option is checked, EZPlot will automatically zoom the graph to
the selected component each time it is drawn.  This setting overrides any manual
changes you might make using the Graph Properties Axis settings.  Uncheck both this
option and the Zoom Full Scale menu option to allow manual changes to remain in
effect the next time the graph is redrawn.

Window Menu Option

EZPlot Location

Depending on the particular application, you may want to size and position the
EZPlot program window in several different orientations.  The following preset
window locations are available:

Left (Ctrl+L)

The EZPlot program window is positioned on the left half of the screen.  This
position is designed so that the EZPlot program window occupies the same location
as the left EZChrom data channel window (Channel "A").  Thus, you would use the
left window position when the component that you are graphing is on the Channel
"B" data window (so you can see the trend plot and chromatogram simultaneously).

Right (Ctrl+R)
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The EZPlot program window is positioned on the right half of the screen.  This
position is designed so that the EZPlot program window occupies the same location
as the right EZChrom data channel window (Channel "B").  Thus, you would use the
right window position when the component that you are graphing is on the Channel
"A" data window (so you can see the trend plot and chromatogram simultaneously).

Top (Ctrl+T)

The EZPlot program window occupies the top 50% of the screen.

Full (Ctrl+F)

The EZPlot program window occupies the top 95% of the screen, leaving room for
only the icons and the EZChrom control panel at the bottom of the screen.

Cascade

Selecting this option causes the EZPlot Trend Plot Window, Data Table Window,
and Alarm Log Window to be displayed "cascaded";  overlaid, and offset in the
upper left hand corner of the Main EZPlot form.

Tile Horizontally

Selecting this option causes the EZPlot Trend Plot Window, Data Table Window,
and Alarm Log Window to be displayed tiled horizontally in the Main EZPlot
Window.

Tile Vertically

Selecting this option causes the EZPlot Trend Plot Window, Data Table Window,
and Alarm Log Window to be displayed tiled vertically in the Main EZPlot Window.

Help Menu Option
Contents

Selecting "Contents" from the EZPlot Help menu option brings up the "Contents"
page of EZPlot Help.

Search for Help On

Puts you directly into the EZPlot Help Search window.

About EZPlot

Displays information about EZPlot including the version number, name and company
of the registered user, and Diablo Analytical contact information.
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Procedures

Setting Graph Properties
The Graph Control's property pages are a set of tabbed dialogs you can use to design
a graph by defining its characteristics.  Once you've entered the property pages, you
can move from one property page to another by clicking on the tab for the desired
page at the top of the property pages window.

The Four Standard Buttons

OK button

When you click this button, the property pages disappear and the graph is redrawn
with any changes you've specified.

Cancel/Close button

This button has two possible markings.

If it reads Cancel, it indicates that any changes you've specified in that property page
haven't yet been applied to the graph.  If you click the button at this point, the
property pages disappear and the graph is redrawn without changes.

If the button reads Close, it means you've already applied changes in that property
page using the Apply Now button.  Clicking the button at this point causes the graph
to be redrawn without further changes.

When you toggle from one property page to another, any changes you've specified in
the first page are immediately applied to the graph.  In the new page, the
Cancel/Close button then initially reads Cancel.

Apply Now button

When you click this button, any specifications you've made in the property pages are
immediately applied to the graph.  The graph is redrawn and the property pages stay
active.  Once you click Apply Now to apply changes to the graph, you can't undo
those changes using the Cancel button.  Also, note that clicking Apply Now changes
the label on the Cancel button to Close.

Help button
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When you click this button, the Graph Control Help file opens.

Style property page

Symbols (default is off)

Select this option to draw a symbol at the position of each data point.  Deselect it for
no symbols.

Lines (default is on)

Select this option to draw lines between data points.  Deselect it for no lines.

Note that if all options in the Markers group (Symbols, Lines, and Sticks) are
deselected, lines are drawn in any case.

Sticks (default is off)

Select this option to draw a vertical "stick" between each data point and the Y origin.
Deselect it for no sticks.

Log Data: Y Axis (default is off)

Select this option for a logarithmic Y axis.  If you select Y Axis and leave X Axis
off, you'll get a log/lin graph; if you select both, you'll get a log/log graph.

Log Data: X Axis (default is off)

Select this option for a logarithmic X axis.  If you select X Axis and leave Y Axis
off, you'll get a lin/log graph; if you select both, you'll get a log/log graph.
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Titles property page

Graph Title

In this box, you can enter text for the graph title, which can be up to 80 characters in
length.  This title appears centered at the top of the graphing window.

When you enter text for a title, the Graph Control adjusts the rest of the graphing
window to provide space--either redrawing the graph and associated objects at a
smaller size or decreasing the space between objects.  When you clear the text box
for a title, you disable it and provide more space for the rest of the graph.

If you enter a title that's too long to appear in a single line, the Graph Control
automatically word-wraps it.  If a title doesn't display at all, it's because the Graph
Control can't make the font small enough to fit all the text in the space provided.
Increase the size of the graphing window to make the title appear.

Bottom Title

In this box, you can enter text for the bottom title, which can be up to 80 characters in
length.  This title appears centered at the bottom of the graphing window.  A bottom
title frequently explains the X axis.

When you enter text for a title, the Graph Control adjusts the rest of the graphing
window to provide space--either redrawing the graph and associated objects at a
smaller size or decreasing the space between objects.  When you clear the text box
for a title, you disable it and provide more space for the rest of the graph.

If you enter a title that's too long to appear in a single line, the Graph Control
automatically word-wraps it.  If a title doesn't display at all, it's because the Graph
Control can't make the font small enough to fit all the text in the space provided.
Increase the size of the graphing window to make the title appear.
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Left Title

This box lets you enter text for the left title, which can be up to 80 characters in
length.

When you enter text for a title, the Graph Control adjusts the rest of the graphing
window to provide space--either redrawing the graph and associated objects at a
smaller size or decreasing the space between objects.  When you clear the text box
for a title, you disable it and provide more space for the rest of the graph.

If you enter a title that's too long to appear in a single line, the Graph Control
automatically word-wraps it.  If a title doesn't display at all, it's because the Graph
Control can't make the font small enough to fit all the text in the space provided.
Increase the size of the graphing window to make the title appear.

Horizontal

Select this option if you want the title to print horizontally.

Up (default)

Select this option if you want the title to print vertically, running in an upward
direction.

Down

Select this option if you want the title to print vertically, running in a downward
direction.

Right Title

This box lets you enter text for the right title, which can be up to 80 characters in
length.

When you enter text for a title, the Graph Control adjusts the rest of the graphing
window to provide space--either redrawing the graph and associated objects at a
smaller size or decreasing the space between objects.  When you clear the text box
for a title, you disable it and provide more space for the rest of the graph.

If you enter a title that's too long to appear in a single line, the Graph Control
automatically word-wraps it.  If a title doesn't display at all, it's because the Graph
Control can't make the font small enough to fit all the text in the space provided.
Increase the size of the graphing window to make the title appear.
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Axis property page

X

Select this option to view and/or change the settings for the X axis.

Y Primary

Select this option to view and/or change the settings for the primary Y axis

Color of Axes (default is automatic black or white)

In this list box, you can choose a color for axes from the current color palette.  The
same color is applied to all axes.  The default color is automatic black or white,
whichever provides more contrast.

Variable (default)

When X is selected in the Apply to Axis group, select this option to draw the X axis
intersecting the Y origin, whether that's at the top, bottom, or middle of the graph.

When Y Primary is selected in the Apply to Axis group, select this option to draw the
primary Y axis intersecting the X origin, whether that's at the left, right, or middle of
the graph.

Left or Top

When X is selected in the Apply to Axis group, select this option to draw the X axis at
the top of the graph, regardless of the location of the Y origin.

When Y Primary is selected in the Apply to Axis group, select this option to draw the
primary Y axis at the left edge of the graph, regardless of the location of the X origin.
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Right or Bottom

When X is selected in the Apply to Axis group, select this option to draw the X axis at
the bottom of the graph, regardless of the location of the Y origin.

When Y Primary is selected in the Apply to Axis group, select this option to draw the
primary Y axis at the right edge of the graph, regardless of the location of the X
origin.

Zero Origin (default)

Select this option to draw the axis including the origin (zero) and extending far
enough in the positive and negative directions to include all of the graph's values.

Variable Origin

Select this option to have the axis "zoom in" on the range of the graph's actual values,
whether or not that range includes zero.

User-Defined

Select this option to set your own values for the minimum, maximum, and number of
ticks for the axis.  When you select User-Defined, the settings in the Range group are
enabled.

Max (enabled by selecting User-Defined in the Scale group)

The Max setting is generally the maximum point of the axis, with the following
exceptions:

If you have a positive Max with a negative Min, the Graph Control may adjust the
maximum or minimum point so that it lies on a tick.  See Ticks.

Min (enabled by selecting User-Defined in the Scale group)

The Min setting is generally the minimum point of the axis, with the following
exceptions:

If you have a positive Max with a negative Min, the Graph Control may adjust the
maximum or minimum point so that it lies on a tick.  See Ticks.

Ticks (enabled by selecting User-Defined in the Scale
group)

The Ticks setting determines the number of ticks along the selected axis.  (Note that
ticks are distinct from tick marks--see the Tick Marks group.)  The effect depends on
the axis and the nature of your data:

For Y axes, and X axes with specific X values, the Ticks setting specifies the number
of ticks from the origin to the setting of either Max or Min, whichever has the higher
magnitude (distance from 0).  For example, if you set Min to -50 and Max to 20,
Ticks applies to the axis segment between 0 and -50.

To determine the Ticks value you want to set, divide the length of the axis (or axis
segment) by the desired interval between ticks.  For the axis segment 0 to -50 we've
just described (whose length is 50 units), if you want to place ticks 25 units apart, set
Ticks to 2.

Both the maximum and minimum points of an axis must fall on a tick.  If you have a
negative Min with a positive Max, the Graph Control may have to move the
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minimum or maximum point to make this happen.  In our example axis, ticks would
be placed at -50, -25, 0, and 25--overriding the Max setting of 20.

Show Tick Marks

Select this option to draw tick marks along the axis.  Deselect it for no tick marks.

Minor

Select this option to draw five "minor" tick marks between standard tick marks.

Every (available for X axis with zero or variable origin only;
default is 1)

If you select Zero Origin or Variable Origin in the Scale group, you can use the
Every setting to specify the frequency with which tick marks are displayed along the
X axis.  An Every setting of 1 places a mark at each tick, a setting of 2 places a mark
at every other tick, and so on.

The X axis must end with a tick mark.  If you set an Every value that doesn't include
the last value on the axis, the Graph Control will extend the axis so that it ends on a
tick mark.

Show Grid Lines

Select this option to draw grid lines perpendicular to the axis, intersecting each tick
mark.  Deselect it for no grid lines.

Line (default is solid)

In this list box, you can choose a style for grid lines.  The same style is applied to
both X and Y grids.

Color (default is automatic black or white)

In this list box, you can choose a color for grids from the current palette.  The same
color is applied to both X and Y grids.  The default color is automatic black or white,
whichever provides more contrast.
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Fonts property page

Graph Title (default)

Select this option to apply font settings to the graph's title, which always appears
centered at the top of the graphing window.

Other Titles

Select this option to apply font settings to the graph's left, right, and bottom titles.
The same settings apply to all three of these titles.

Labels

Select this option to apply font settings to the graph's labels--including axis labels.
The same settings apply to all labels in use in the graph.

Legend

Select this option to apply font settings to the graph's legend.

Name (default is Arial)

In this list box, you can choose any installed Windows font for the selected text.

Italic (default is off)

Select this option to have the Graph Control italicize the text.

Bold (default is off)

Select this option to have the Graph Control display the text in boldface.
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Underline (default is off)

Select this option to have the Graph Control underline the text.

Smart Scale (default is on)

Select this option to have the Graph Control automatically use smaller type if the size
you specify (using the Smaller-Bigger scroll bar) makes the text too large for the
available space.  If the Graph Control can't make the type small enough to fit, the text
won't display at all.

If you deselect Smart Scale, the Graph Control won't attempt to use type smaller than
you specify with the Smaller-Bigger scroll bar.  If the text is too large for the space
available, it simply won't display.

Smaller-Bigger

This scroll bar lets you set the size of type.  If Smart Scale is selected, the Graph
Control may override your setting to make the text small enough to fit in the graphing
window.

Each click on the Smaller end of the scroll bar decreases the text size by 5 arbitrary
units (to a minimum of 50), and each click on the Bigger end increases it by 5 units
(to a maximum of 500).  The initial size depends on which type of text you're sizing.

Reset

Click this button to reset the text size to the default.

Markers property page
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Click to Select a Point or Set

When you move the mouse pointer over the graph drawing at the upper left of the
Markers page, the pointer becomes a large arrow.  It is important for you to point and
click on the point that you want to apply settings to, not the line.

Apply To group

This group shows you the point or set number of the graph object you've selected in
the graph illustration.

Set.  A data set (plot) number is shown.  Your settings apply to a particular data set.

Point.  A point number is shown.  Your settings apply to a particular data point.

Reset All button

Click this button to return all values in the Markers property page to their default.

Color (default is automatic color selection)

In this list box, you can choose a color for the selected marker from the current
palette.

By default, the Graph Control assigns an automatic series of colors to markers,
chosen for variety.  If you override this default by setting your own color for one
marker, you have to set colors for the remaining markers as well--otherwise, they'll
be shown in black.

Pattern list box

Pattern (default is solid).  From this list box, you can choose a pattern for the
selected marker.  If you don't choose one, the marker appears in a solid color.

Symbols group

Symbol (default is automatic symbol).  In this list box, you can choose one of 14
symbol options.

By default, the Graph Control assigns an automatic series of symbols to data sets,
chosen for variety.  If you override this default by setting your own symbol for one
set, you have to set symbols for any remaining sets as well--otherwise, they'll all
default to the first available symbol (+).

Size.  This scroll bar sets the size for symbols, based on a default of 100 arbitrary
units.  Each click to the left decreases the symbol size by 5 units (to a minimum of
10), and each click to the right increases it by 5 units (to a maximum of 1000).

Lines group

Thick (default is on).  Select this option to enable thick lines, which are three pixels
thick by default.  Deselect it for thin lines, which are one pixel thick.

For polar, line, and logarithmic graphs, you can choose a line thickness of one to five
pixels (overriding the default three pixels) in the list box.  This setting applies to all
lines in the graph.  You can't set your own thickness for high-low-close or open-high-
low-close markers, which are always three pixels thick when Thick is on.

Patterned (default is off).  Select this option to enable patterned lines.  Then, in the
list box, you can choose a pattern for each line.
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Background property page

Apply To

In the Apply To subgroup, you can select the graph object you want to apply styles
and colors to--the Graph Title (default), Bottom Title, Left Title, Right Title,
Legend, or Graph (including the graph itself and its axes).

No Style (default)

Select this option for no styling effect.

Border

Select this option to draw a border around the object.

Drop Shadow

Select this option to draw a black drop shadow behind the object.

Raised

Select this option to draw a border with a "raised" appearance around the object.

Lowered

Select this option to draw a border with a "lowered" appearance around the object.

Text Color (default is automatic black or white)

In this list box, you can choose a color for the object's text from the current palette.
The default color is automatic black or white, whichever provides the most contrast.
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Background (default is automatic black or white)

In this list box, you can choose a background color for the rectangular area
surrounding a graph.  The default color is automatic black or white, whichever
provides the most contrast.

Background Color (default is White)

In this list box, you can choose a background color for the graphing window from the
current color palette.

Backdrop (default is None)

This list box lets you choose a type of graphic image (bitmap or metafile) to use for
the backdrop of the graphing window.  You also choose how the image is displayed--
centered, tiled, or stretched.

File

In this text box, you can enter the filename for the graph's backdrop image.  If you
don't include a path to the file as part of this string, the Graph Control searches the
current directory.  The appropriate file extension (.BMP or .WMF) is added
automatically, according to your selection in the Backdrop list box.

Browse

Click this button if you want to call up a standard Windows Open dialog to locate a
backdrop file.

Palette

In this list box, you can choose a 16-color or 128-color palette for your screen.
Whenever you have to set a color in the Graph control, this palette determines the
choices in the color list box.

• 16-color palettes consist of 16 differentiated colors--default, pastel, or
grayscale.

• 128-color palettes always consist of the 16 colors from the default
palette, followed by 96 colors that vary according to the palette you
select. The Graph control reserves 16 additional colors for special
graphic needs, such as drawing the sides of 3D bars; you can't select
these reserved colors yourself.
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Legend property page

Legend Text

Click this button to call up the Legend Text dialog, which lets you enter the
individual text strings for a graph's legend.  The number of legend strings is equal to
the Sets value in the Data Dimension group.

Position (default is right-hand center)

If your graph has a legend, you can use these buttons to set the legend's position
around the edges of the graphing window.

If you choose the top center or bottom center position, legend items are drawn
horizontally in a single row. At all other positions, legend items are stacked
vertically.

Note that if you have the Legend Size set to Maximum, you may see no difference
when you select top/center/bottom or left/center/right.

Size (default is maximum)

This scroll bar lets you set the size of a legend--including the text, marker, and gap
between items. The Size setting is a percentage of the maximum legend size. The
default setting is 100, and each click to the left or right decreases or increases the
setting by 1 (to a minimum of 0 or maximum of 100).

Real-time plotting with the EZChrom data system
One of the main purposes for the development of EZPlot was to add real-time trend-
plotting capabilities to the EZChrom 200 data system.  This capability is very useful
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for on-line or in-situ process analyses where concentrations change quickly in real
time, and decisions must be made based on these changes.

Real-Time Plotting Procedure:
1 Start both the EZChrom and EZPlot Applications

2 Orient the EZChrom and EZPlot program menus as desired

3 Set up EZChrom for Real-Time Plotting (see Setting up EZChrom 200
for Real-Time Plotting on page 36).

4 Set up EZPlot for Real-Time Plotting (see Setting up EZPlot for Real-
Time Plotting on page 36).

5 Start EZChrom Data Acquisition

Setting Control Limits and Alarms
EZPlot has no way of knowing the identity or number of components that will be
plotted during real-time plotting until the first set of component data has been sent
from EZChrom.  This makes it difficult to set control limits and alarms in advance.
Consequently, you should use the following approach to set the control limits and
alarms initially.

1. Set up EZChrom and EZPlot for real time plotting

2. Have EZChrom perform one run using the desired method.  This will
cause the current set of components to be sent to EZPlot

3. Set the desired component control limits and alarms in EZPlot

4. Re-configure EZChrom to collect the desired number of runs

5. Re-start EZChrom data acquisition

EZPlot also allows you to use control limits and alarms from an existing data file (see
Use Limits and Alarms From on page 37).  This is useful if you have already set up
alarms and limits for one data file, and you want to use the same alarms and limits for
a new data file.  It is important that the number and order of components is the same
for each data file.

Component Order
During real-time plotting, EZChrom sends EZPlot the Channel B component results
first, followed by the Channel A component results.  Consequently, this is the same
order that component results will be displayed in EZPlot.

If your method contains the same component in both the EZChrom Channel A and
Channel B peak tables, you might consider adding a channel "indicator" to
component names when you set up the peak tables (e.g. "Acetone (A)" and "Acetone
(B)").

Important Note: EZChrom uses the opposite order when it saves data to text files
(Channel A followed by Channel B).  Keep this in mind if you are comparing data
collected by real-time plotting with data imported from EZChrom "PRN" files.



Copyright 1997, Diablo Analytical, Inc. EZPlot 4.5 Procedures  ••  33

Adjusting Parameters During Real-Time Plotting
While EZChrom 200 is sampling and collecting a chromatogram, it uses a large
percentage of the computer's processor time.  This means that it may be difficult for
you to make any adjustments to EZPlot parameters while EZChrom is running.

Setting up EZChrom 200 for Real-Time Plotting
1. The Run ID value that you enter into the EZChrom Run Setup Dialog

box is used as the source of the data file name by EZPlot (after adding
the ".EZP" file extension).  If a file already exists with this name,
EZPlot automatically appends new data to the end of the existing file,
otherwise EZPlot creates a new data file.  Important:  Make sure that
your Run ID is a valid DOS filename.

2 The "Time Between Injections" needs to be at least 3-5 seconds to
allow EZPlot time to perform calculations and plot the results.

EZChrom Run Dialog Box Set up for Real-Time Plotting With
EZPlot:

Setting up EZPlot for Real-Time Plotting
Use the "Real-Time Plot…" option of the "File" menu to configure EZPlot for real-
time trend plotting of EZChrom data.
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Real-Time Trend-Plot Configuration Dialog

Graph Template

You can select a graph template to apply to the real-time trend plot.  EZPlot stores
graph formatting information in files with an extension of GSP.  If you leave the
setting as "Default", EZPlot will use the following graph formatting:

• If a graph template file already exists for this data file, it will be used

• Otherwise, EZPlot default formatting will be used.

Please Note:  The specified graph template is applied only at the beginning of data
acquisition, after collection of the first data point (Run 1).  If you want to apply a
different graph template later, use the Apply Graph Template option of the File
menu.

Use Limits and Alarms From

Control limit and alarm configuration information is stored in EZPlot data files with
an extension of ".EZP".  These files also contain information on the components that
have been selected to plot.  You can choose an already-existing data file from which
EZPlot will extract and use this information.  If you choose to use this option, make
sure that the data file that you select contains the same set of components in the same
order as the data that will be collected.

If you leave the setting as "Default", EZPlot will use the following graph formatting:

• If this data file already exists, the existing configuration will be used

• Otherwise, EZPlot defaults to plotting the first 10 components with no
control limits or alarms

Please Note:  The specified configuration is applied only at the beginning of data
acquisition, after collection of the first data point (Run 1).  If you want to change
alarms or control limits later, use the Limits and Alarms option of the Format
menu.  If you want to plot a different set of components, use the Plot Data option of
the File menu.

Alarm Delay

Enter the number of runs that EZPlot should delay before evaluating and generating
alarms.  This parameter is useful if you are using calculated control limits for any of
the component alarms.  This allows you to select how many data points will be used
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to calculate the average, and standard deviation before the control limits are used to
generate alarms.

Clear Current Data

If you select this checkbox, any data, graphs, and alarms currently displayed  in
EZPlot will be cleared before starting real-time plotting.  If you choose not to clear
current data, then you should make sure that the EZChrom method will generate the
same number of components in the same order as those that are already loaded in
EZPlot.

Save real-time data to disk

If you select this check box, the component concentrations from each new run will be
saved to disk in real time in addition to being added to the data table.  The data file
that will be used is the "Run ID" (with an extension of ".EZP") that you specify in
EZChrom.  If this file already exists, data will be appended to the end of the file.

Important Note: EZPlot uses the EZChrom Run ID that was active for run number
1 as the EZPlot data file name.  If you change the EZChrom Run ID during
acquisition without clearing current data, then data will continue to be written to the
initial data file name even though the Run ID has changed.

Start/Stop

Pressing the Start button causes EZPlot to clear the current data if you have selected
this option, and then make a DDE connection to EZChrom.  If EZChrom isn't already
running, you will receive an error message.  Once a satisfactory connection has been
made to EZChrom, the EZChrom Status Panel will turn from Gray to Green, and
EZPlot will wait for data from EZChrom.

If there is already a real-time plotting DDE connection to EZChrom, this button will
instead be a Stop button.  Pressing the Stop button terminates the DDE connection
to EZChrom, ending real-time plotting.

Cancel

This button closes the Real-Time Plot configuration dialog box without clearing the
current data or connecting to EZChrom.

EZPlot Control Limits and Alarms
EZPlot allows the user to configure control limits and alarms independently for each
component in a data file.  To configure control limits and alarms, select Control
Limits and Alarms from the Format menu option.  The following dialog box will
be displayed.
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EZPlot Control Limits and Alarms

Component

Select the component for which  you want to set control limits or alarms using the <
and > buttons.

View All Components in Data File

If this option is selected, then the < and > buttons will scroll through All the
components in the data file.

View Plotted Components Only

If this option is selected, then the < and > buttons will scroll only through those
components that have been plotted.

Control Limits

EZPlot allows you to set two kinds of control limits:

• Calculated control limits based on the average and standard deviation of
the current data set.  This control limit has the form of Average +/- n *
Standard Deviation, where you supply the standard deviation
multiplier, n.  When data is loaded from a data file, the control limits
are calculated using all the data in the data file.  For real-time data
collection, the control limits will be updated after each new data point is
collected.  If a calculated control limit is negative, it will automatically
be reset to 0.

• Fixed upper and / or lower control limits.  The user enters fixed limits
that are based on their own criteria.

If you specify control limits for a component, the control limit value(s) will be placed
in the Upper CL and Lower CL rows of the data table.  If you want to view the
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control limits graphically, plot the desired component, and then select that
component in the component selection list box located on the Main EZPlot Window.

Alarm

If you have defined control limits for a particular component, you can use the alarm
check boxes to determine if an alarm will be generated when a component
concentration exceeds either the upper or lower control limits.  When an alarm
occurs, a line is added to the EZPlot Alarm Log Window.

OK

When you press the OK button, EZPlot recalculates all Control Limits, re-evaluates
alarms, and then replots the graph to reflect any changes made to control limits.

Cancel

If you press the Cancel button, the dialog box will be closed without recalculating
control limits and alarms.
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Appendix

EZPlot Troubleshooting Procedure

I.  Check System Configuration
First, make sure that your system is configured properly to run EZPlot.

A.  Windows Version

You must be running one of the following operating systems:

• Windows 3.11

• Windows 95

B.  EZChrom Version

You must be running the following version of EZChrom:

• EZChrom 200 Version 4.5

C.  Computer System

The following computer hardware is required:

• A 50-MHz 80486 or Better Computer

• 16 MB or More System Memory (RAM)

II.  Isolate Problem to Application
If your system is configured properly to run EZPlot, you must next determine if the
problem is associated with EZChrom or EZPlot.

A.  EZChrom Data Acquisition

1. Close all Windows applications and start EZChrom 200

2. Load and run a known method using a known sample and save the data
to a PRN file
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B.  EZPlot Data Analysis

1. Close EZChrom and all other Windows Applications

2. Start EZPlot

3. Import the PRN File created in step II A

4. Plot the desired components

C.  Real-Time Trend Plotting with both EZChrom and EZPlot

1. Open both EZChrom and EZPlot

2. Configure EZPlot for Real-time plotting

3. Load and run the same method with the same sample used to generate
the data in step II A.

III.  Access Proper Technical Support Organization

Problem Occured in Step I

• Your system is not configured properly to run EZPlot.  Make the
necessary modifications to your system and try rerunning EZPlot.

Problem Occurred in Step II A

• Contact MTI Technical Support at (510) 490-0900.

Problem Occurred in Step II B or C

• Contact Diablo Analytical technical support (see Technical Support on
page 4)
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Technical Support Fax Back Form
Use this fax back form for submitting technical support questions and product enhancement suggestions.

• By Phone: Call us at (510) 609-1150
• By Fax: Fax to (510) 609-9360
• By E-Mail: Send an e-mail message to ezplot@diab.com

Contact Information:

Contact Name: _____________________________________________________________

Company: ____________________________________________________________________

Telephone: __________________________ Fax: _____________________________

E-Mail Address: ____________________________________________________________________

EZPlot Serial Number:

Supplemental Information:

Please provide the following information regarding the primary computer system that is running EZPlot

Operating System Platform: £ Windows 3.1/3.11 £ Windows 95 £ Other:  _________

Computer Style: £ Laptop £ Desktop

Computer Processor: £ 486 £ Pentium £ Other:  ___________

Processor Speed: _____________  MHz System Memory (RAM): ____________  MBytes

Describe the nature of your problem or suggestion.  Make sure to indicate if the problem is reproducible, and
if so, the exact steps that produce the problem.  Use additional sheets if necessary.


